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Navigation (5.2.3 or higher)

A good understanding of Sterling B2B Integrator navigation will enhance your
experience with the product.

User Interface
The IBM® Sterling B2B Integrator user interface (UI) is designed to simplify the
navigation between the functional areas of the system. Throughout the user
interface, navigation aids such as the Back and Next buttons, menu organization,
and task flow are consistent, enabling you to confidently and quickly complete
your activities.

The IBM Sterling B2B Integrator UI enables you to create, configure, and manage
your operations by steering you toward the activities that you must undertake.

The system provides access to files, business processes, Web templates, services,
and product features according to permissions assigned to your user account by
the system administrator. Thus, the activities that you can perform and the sections
of the UI you have access to depend on the permissions assigned. In general,
however, the UI enables the creation and management of:
v User accounts and permissions
v Trading partner profiles
v B2B packaging and communications definitions
v Translation maps (using the Map Editor)
v Process definitions (business process models)
v Reports
v Trading partners
v Online forms (Web templates).

In addition, the UI enables you to:
v Configure services and adapters
v Monitor and configure system operations
v Manually start and stop processes
v Customize display.

Configure Browser Settings
Some browsers and/or operating systems require additional configuration in order
to correctly render the Sterling B2B Integrator user interface in certain languages.
Use the procedures provided in this section to properly configure a browser to
display the Sterling B2B Integrator user interface in the appropriate language.

Note: If your browser is unable to display the user interface properly or you see a
mixture of English and another language, this is an indication that the browser is
configured incorrectly. You may also need to install additional fonts on the Sterling
B2B Integrator server.
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Support for Foreign Languages

Note: Sterling B2B Integrator 5.2.3 product code is designed to work with Latin
based English only input. The use of any other type of input may have uncertain
results and is not supported as part of the 5.2.3 release.

The Sterling B2B Integrator 5.2.3 user interface supports several new foreign
languages:
v French
v German
v Italian
v Japanese
v Korean
v Polish
v Portuguese (Brazilian)
v Simplified Chinese
v Traditional Chinese

Four of these languages involve expanded Unicode character sets:
v Japanese
v Korean
v Simplified Chinese
v Traditional Chinese

The implementation of these languages in your environment may require the
addition of new Unicode fonts on your server:

If... then...

Sterling B2B Integrator is on a server that
already supports these languages,

you do not need to install any additional
fonts.

you are installing on a server that is only
setup for the Latin alphabet and you have
users who need to view the Sterling B2B
Integrator user interface in any of the Asian
languages,

you need to have the fonts for these
languages installed.

A way to test this is to create a user with one of the new languages and setup their
browser to use that language as it's primary language. Log in to the system and
review the user interface. If you see a mixture of English and the new language,
your configuration is not correct. You will need to verify the browser is setup
correctly and review the fonts installed on the server.

The installation of additional fonts/languages on the server should be done in
coordination with your technical support team. Be sure to include a Unicode Sans
Serif font on your server.

Note: While multiple foreign languages are supported, a user account should be
configured to use one specific language to avoid user interface display issues.
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Add a Custom Language Preference Code
About this task

In order for your browser to display the Sterling B2B Integrator user interface and
address bar text correctly in a foreign language, you must specify the appropriate
language preference code for the browser.

Sterling B2B Integrator 5.2.3 supports the following language preference codes:
v de
v en
v en-US
v es
v fr
v it
v ja
v ko
v pt-BR
v zh
v zh-TW

Your browser must be configured to use one of these specific language preference
codes to view the Sterling B2B Integrator user interface.

Note: Most browsers provide a default listing of language preference codes.
However, Sterling B2B Integrator requires the use of the specific codes as listed
here. For example, you cannot use the default German (Germany) [de-DE], you
must use [de].

You may need to add these supported codes as a custom language preference code
in your browser.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an IE
window.

Procedure
1. Open an IE browser window.
2. Select Tools > Internet Options.
3. At the bottom of the window under Appearance, click Languages.
4. Click Add to display the Add Language window.
5. In the User defined: text box, enter the appropriate language preference code

from the list below:
v de
v en
v en-US
v es
v fr
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v it
v ja
v ko
v pt-BR
v zh
v zh-TW

6. Click OK. The added code should display in the Language: listing in the
Language Preference window. An example entry would be, User Defined
[de].

7. (Optional) Move the added language up to be the first one listed if there are
multiple languages listed.
a. Select the newly added language.
b. Click Move up.

The newly added language should now appear first in the Language
listing.

8. Click OK to save your Language Preference settings.
9. Click OK to close the Internet Options window.

10. Close your browser window.
11. Open a new browser window and access the Sterling B2B Integrator user

interface to verify your changes have been applied.

Change Default Browser Font
About this task

Some languages require the use of special fonts to properly display the Sterling
B2B Integrator user interface. The client computer must be configured to display
these types of fonts. Each Windows client must be configured appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to change the default browser font for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure
1. Determine which fonts are needed to support your needed language and

verify they are installed on the server.

Note: The installation of additional fonts/languages on the server should be
done in coordination with your technical support team. Be sure to include a
Unicode Sans Serif font on your server.

2. Open an IE browser window.
3. Select Tools > Internet Options.
4. At the bottom of the window under Appearance, click Fonts.
5. From the Language Script drop-down menu, change the Latin based value to

the appropriate script for your needed language.
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Note: If your encoding is not available, you may need to install a new
version of Internet Explorer, but make sure you install the appropriate
international options.

6. Select a Webpage font and a Plain text font appropriate for the new language.
A Plain text font is one in which all the characters take up the same amount
of space and is associated with older computer terminals.

Note: If no fonts are listed in the menus, then you need to install fonts
designed for that encoding.

7. Click OK to close the Fonts window.
8. Click OK again to close the Internet Options window.
9. Close your browser window.

10. Open a new browser window and access the Sterling B2B Integrator user
interface to verify your changes have been applied.

Set the Client Character Display
About this task

To use special characters, such as for various languages, the client computer must
be configured to display these types of characters. In order for Unicode characters
to display correctly in the application, each Windows client must be configured
appropriately.

Note: The instructions for configuring a browser’s display will differ for each
browser. Refer to your chosen browser’s documentation for specific instructions on
configuring that browser’s display.

The following is an example of how to configure a client machine display for an
Internet Explorer (IE) window.

To configure a client machines display for IE:

Procedure
1. Open an IE browser window.
2. Select View > Encoding > Auto-Select.

Clearing Browser and Java Plugin Caches Before Initial
Deployment

About this task

Once the Sterling B2B Integrator is ready for deployment, each user must clear the
browser and Java Plugin caches on their client machines before launching Sterling
B2B Integrator. This requirement applies to all browsers.

To clear the browser and java caches, do the following:

Procedure
1. From the browser menu bar, select Settings > Control Panel > Internet

Options.
2. Select the General tab, and in the Temporary Internet Files panel, click Delete

Files. The Delete Files dialog displays.
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3. Check the Delete All Offline Content checkbox. Click OK until the Internet
Properties window closes. The browser cache is cleared.

4. From the Windows start menu, select Settings > Control Panel > Java.
5. Select the General tab, and in the Temporary Internet Files panel, click Settings.

The Temporary Files Settings dialog displays.
6. In the Disk Space panel, click Delete Files. The Delete Temporary Files pop-up

window displays.
7. Click OK until the Java Control Panel window closes.

General Internet Explorer Browser Settings
When using Sterling B2B Integrator without any customizations, you need to set
the General Browser settings for your Internet Explorer in order to obtain the best
browser performance.

Note: This can impact the display of reports and search listings.

To set your general browser settings:
1. From the Internet Explorer menu, select Tools > Internet Options.

The Internet Options window opens to the General tab.
2. Locate the Browsing history section and click Settings.

The Temporary Internet Files and History Settings window opens.
3. Below Check for newer versions of stored pages: select the Everytime I visit

the webpage option.
4. Click OK to save your changes.
5. Click OK to apply the changes.
6. Close the browser window and re-open it.

The browser is now set to check for updates to pages everytime a page is
accessed rather than relying upon a cached version.

Internet Explorer Security Settings
About this task

When using Sterling B2B Integrator without any customization, you need to set
security settings for your Internet Explorer to obtain the best browser performance.

To configure the Internet Explorer security and privacy settings:

Procedure
1. From the Internet Explorer menu, select Tools > Internet Options.
2. Click the Security tab.
3. Select the Web content zone from which Sterling B2B Integrator is accessed.
4. Set the security level to Medium-low.
5. Click Custom Level and set your security settings according to the following

table:

Internet Explorer Security Setting Sterling B2B Integrator

.NET Framework

Loose XAML Enable

XAML browser applications Enable
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Internet Explorer Security Setting Sterling B2B Integrator

XPS documents Enable

.NET Framework-reliant Components

Permissions for components with manifests High Safety

Run components not signed with Authenticode Enable

Run components signed with Authenticode Enable

ActiveX Controls and Plugins

Allow previously unused ActiveX controls to run
without prompt

Enable

Allow Scriptlets Enable

Automatic prompting for ActiveX controls Enable

Binary and script behaviors Enabled

Display video and animation on a webpage that
does not use external media player

Disable

Download signed ActiveX controls Prompt

Download unsigned ActiveX controls Prompt

Initialize and script ActiveX controls not marked as
safe for scripting

Prompt

Run ActiveX controls and plugins Prompt/Enable

Script ActiveX controls marked as safe for scripting Enable

Downloads

Automatic prompting for file downloads Enable

File download Enable

Font download Prompt

Enable .NET Framework setup Enable

Java VM

Java permissions Medium safety

Miscellaneous

Access data sources across domains Enable

Allow META REFRESH Enable

Allow scripting of Internet Explorer web browser
control

Enable

Allow script-initiated windows without size or
position constraints

Enable

Allow webpages to use restricted protocols for
active contents

Prompt

Allow websites to open windows without address
or status bars

Enable

Display mixed content Prompt

Do not prompt for client certificate selection when
no certificates or only one certificate exists

Enable

Drag and drop or copy and paste files Prompt

Include local directory path when uploading files
to a server

Enable
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Internet Explorer Security Setting Sterling B2B Integrator

Installation of desktop items Prompt

Launching applications and unsafe files Prompt

Launching programs and files in an IFRAME Prompt

Navigate sub-frames across different domains Enable

Open files based on content, not file extension Enable

Software channel permissions Medium safety

Submit non-encrypted form data Prompt

Use Phishing Filter Disable

Use Pop-up Blocker Disable

Userdata persistence Enable

Websites in less privilged web content zone can
navigate into this zone

Prompt

Scripting

Active scripting Enable

Allow Programmatic clipboard access Prompt

Allow status bar updates via script Enable

Allow websites to prompt for information using
scripted windows

Enable

Scripting of Java applets Enable

User Authentication

Logon Prompt for user name and password

6. Click OK to save your settings.
7. Click OK to save the new settings and Apply to implement the settings. The

new settings are applied when a new browser window is opened.

Accessing the User Interface
Before you can access the IBM Sterling B2B Integrator UI, the system must be
installed and you must log in.

After IBM Sterling B2B Integrator is installed, your system administrator creates
your user account and assigns user permissions related to using the various system
components. Before accessing IBM Sterling B2B Integrator for the first time, contact
your system administrator to obtain:
v IBM Sterling B2B Integrator UI URL for the log in page
v Your User ID
v Your Password

Log In and Out
About this task

To log in to IBM Sterling B2B Integrator:
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Procedure
1. Navigate to theIBM Sterling B2B Integrator Login page.
2. Enter your User ID.
3. Enter your Password.
4. Click Sign In. If the Login page is displayed again, this indicates that your

system administrator requires you to create a new password the first time you
log in, for security reasons. Enter a new password in the corresponding fields,
and click Sign In again. The Admin Console pane is displayed.

Note: If your User ID or password or both do not work, contact your system
administrator.

What to do next

To log out click Logout in the top right-hand corner of the page. This ends your
session and displays the Login Page.

Note: Close additional windows, for example, SQL Manager, before you click
Logout.

Troubleshoot a Failed User Login

If you fail to log in to IBM Sterling B2B Integrator, consider the following factors:
v Passwords are case-sensitive. Check whether the Caps Lock key is off.
v Repeatedly entering an invalid User ID and Password can lock you out of the

system. The system administrator configures the number of failed login attempts
that are allowed.

If you are locked out, try the following strategies:
v Log in using any other computer that has access to IBM Sterling B2B Integrator.

Lock outs affect only the computer being used and do not apply to the User ID
or Password being attempted.

v Wait for thirty minutes, which is the duration of the lock out. Then try again
using the same computer.

v Request the system administrator to deactivate the lock. The administrator uses
the Lock Manager page in IBM Sterling B2B Integrator to deactivate the lock.

Lock Out Parameter
The lock out parameter specifies the number of consecutive failed login attempts
that are allowed before a user is locked out of the application.

By default, the lock out parameter (ConsecFailedAttempts) is set to 0, which tells
the login servlet to not lock users, regardless of the number of failures. System
administrators can set this lock out number to any numeric value by editing the
ui.properties.in file in the properties directory.

CAUTION:
Make changes to the ui.properties.in file and not the ui.properties file. If you
make changes to the ui.properties file, and restart the system, the changes you
made to the ui.properties file are overwritten by the ui.properties.in file.

The ConsecFailedAttempts parameter controls the user lock out behavior for:
v IBM Sterling B2B Integrator Administration Menu

Navigation (5.2.3 or higher) 9



v FTP Server Adapter
v SSH/SFTP Server Adapter (for SFTP and SCP protocols)
v MBI (Mailbox Browser Interface)

Edit the Lock Out Parameter
About this task

To edit the lock out parameter:

Procedure
1. Stop IBM Sterling B2B Integrator.
2. Navigate to the installation directory.
3. Navigate to the bin directory.
4. Navigate to the properties directory.
5. Locate the ui.properties.in.
6. Using a text editor, open ui.properties.in.
7. Locate the ConsecFailedAttempts= 0 entry.
8. Highlight and change 0 to the new number of login attempts.
9. Save the ui.properties.in file under the same name in the same location.

10. Run the setupfiles script.
11. Restart IBM Sterling B2B Integrator. The changes you made in the

ui.properties.in file are applied to the ui.properties file and are applied to
all user accounts.

Admin Console
When you log in to IBM Sterling B2B Integrator, the Admin Console pane is
displayed. The following figure illustrates the Admin Console pane.

The Admin Console pane is your access point to all the standard IBM Sterling B2B
Integrator features. The UI uses a dashboard design that enables the display of
additional optional panes that are available with other IBM Sterling B2B Integrator
applications. The Operations option provides access to system administration
information, including system troubleshooting, performance tuning, system logs,
and license information.
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The interface display can be customized in a variety of ways. Therefore, if any of
the following are true, the Admin Console pane may not be displayed when you
log in, or look different from that shown in the previous figure:
v You are logged in to a IBM Sterling B2B Integrator edition, such as the AS2

Edition. In this case, an edition-specific pane may be displayed.
v The permissions associated with your user account limit your navigation of the

UI to a smaller subset of components. In this case, some of the menu options
may not be displayed.

For purposes of exploring the interface, this documentation assumes that your
interface contains all the standard menu options and that the Admin Console pane
is your entry point to the system.

Portlet View Pane
While the Admin Console is, by default, the Home page of the IBM Sterling B2B
Integrator interface, other panes can be tailored for more specific uses through the
use of portlets, that is, snapshots that are arranged on the pane to work as
windows to your system activity.

The portlet view panes, such as the Operator pane (click the tab to view it),
provide at-a-glance visibility into your processing operations. You can customize
your panes and select a specific portlet display to better suit the way you use IBM
Sterling B2B Integrator.

Procedure Page
Procedure pages are the typical pages used in the Admin Console pane, as well as
the home page pane for the AS2 edition, to enable you to complete necessary
activities, such as configuring services and adapters, creating trading partner
profiles, creating reports, and searching for specific information.

The following figure shows the standard parts of the interface pages:

The following table describes the labeled parts:

Page Component Description

Manage Layout link Links to the Customize pane for customizing Dashboard panes.
You can customize the pane and portlet content.
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Page Component Description

Navigation menu The appropriate menu is displayed according to the pane your
are in. Provides access to process-related activities.

Central page area Displays the page title and the body of the page that are related
to the menu selection used to navigate to the page.

Navigation and task
buttons

May include Back, Next, Cancel, Return, Save, Validate, and
Finish. Enables you to navigate back and forth in the pages that
make up a procedure, save changes, complete a task, cancel a
procedure, or return to the initial page in a procedure or topical
area.
Note: Always use the IBM Sterling B2B Integrator Back and
Next buttons instead of your browser's Back and Forward arrow
buttons. Using the browser buttons may cause errors.

Page information Describes the page and how to use it. May include a list of steps
to complete a task.

Menus
The menus in the IBM Sterling B2B Integrator Dashboard interface work in the
same manner to provide access to the different components of IBM Sterling B2B
Integrator.

The following figure displays a typical menu with the parts labeled:

The following table describes the parts of the menus:

Menu Component Description

Title bar Identifies the menu.

Help links Provide quick navigation:

v Home– Displays the home page for the application or
functional area you are working in.

v Site Map– Displays a site map of the application or
functional area you are working in. Items on the site maps are
links that can be used to navigate to a specific interface
component.

v Support– Displays information about how to get technical
support and contains a link to open a support case.

v Help – Opens a separate window to display the onlinw
Documentation Library, where you can access all IBM Sterling
B2B Integrator documentation.
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Menu Component Description

Primary headings Indicates the categories of menu selection you can access by
expanding the headings. To expand the menu, click the primary
heading. Click again to hide the related menu options.

Some primary headings have secondary headings under them, providing access to
another tier of menu options. The following menu shows a primary heading,
Trading Partner and a secondary heading, Document Envelopes. Both these
headings can be expanded by clicking the corresponding arrow:

The following table describes the primary heading menu options of the
Administration Menu because they relate to specific tasks. Remember that some of
the menu options illustrated and described in this document may not be displayed
in your interface, depending on the permissions assigned in your user account by
the administrator who created it.

You should navigate to the Admin Console pane in the interface as you read this
section to gain a better understanding.

For information about the specific activities you can perform from a given page,
see the page information (Side Help) on the corresponding page in the interface.
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Primary Menu
Heading Description

Business Processes Provides access to pages for business process management
activities, including:

v Accessing the Graphical Process Modeler to create business
process models

v Creating, deleting, and searching for business process definitions

v Checking business processes in and out of IBM Sterling B2B
Integrator

v Starting, stopping, enabling, and disabling processes

v Monitoring current processes for information such as status, start
and stop time, and errors

v Determining what other processes are related to a specific
business process

v Searching for information about service activity within a business
process

v Performing a wide range of advanced searches for business
processes, documents, EDIINT transactions, and ebXML message
flows

Trading Partner Provides access to pages for trading partner management activities,
including:

v Creating, modifying, and searching for trading partner profiles

v Configuring and searching for advanced trading partner
information such as transport records, document exchange
information, delivery channels, and packaging information

v Creating, checking in, and searching for digital certificates

v Creating, configuring, and searching for document envelopes and
related information such as contents of the EDI Sequence Check
Queue and the control number history

v Creating and locating contracts

v Creating and locating code lists

v Configuring SSH Remote Profiles

v Managing Odette FTP Partner Profiles

v Managing PGP Server, PGP Partner, and PGP Sponsor
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Primary Menu
Heading Description

Deployment Provides access to pages for services-related activities, including:

v Searching for information about specific services

v Creating and searching for service configurations

v Creating and searching for schedules for business processes and
services

v Accessing the Map Editor application and EDI or CII standards

v Checking in and searching for translation maps, XSL style sheets,
XML schemas or DTDs, WSDLs (Web Services Description
Languages), and Collaboration Protocol Agreements for ebXML

v Checking in, searching for, and exporting Web templates and
resources

v Creating and managing mailboxes

v Checking in and searching for ebXML Business Process
Specification Schemas and assigning business processes to
activities in a schema

v Importing and exporting system resources

v Configuring adapter utilities such as SAP or SWIFTNet

v Creating and packaging custom services and adapters

Operations Provides access to pages for systems operations-related activities,
including:

v Troubleshooting system problems

v Creating, scheduling, searching for, and viewing other reports

v Configuring performance tuning

v Entering a support case

v Viewing system logs

v Updating and searching for product licenses

v Monitoring running threads and messages

v Configuring and managing archive settings and locked resources

v Adding and configuring perimeter services

v Configuring and managing proxy servers

Accounts Provides access to pages for user account-related activities,
including:

v Creating and searching for user groups, permissions, accounts,
and password policies

v Creating and searching for user news messages

v Modifying your user account settings

Wizard Pages and Navigation Buttons
IBM Sterling B2B Integrator uses wizard pages to guide you through the steps
involved in your procedures, such as configuring services and adapters, creating
trading profiles and user accounts, and so on.

Wizards present fields in sets on a progressive series of interface pages. The fields
are used to collect information on configuration, such as a trading profile. Each of
the wizard pages, which progress in a logical order, comprises a set of fields and
navigation buttons. After you enter the data for the first set of fields in a page, you
click a navigation button, such as Next, to progress to the next page. This process
continues until you complete the steps involved in a given task. For example,
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when you select Business Processes > Manager from the Administration Menu,
the Business Process Manager page is displayed. By clicking Go! adjacent to the
words Create Process Definition you start the related wizard page flow, in this
case, the Business Process flow.

The first page in the Business Process wizard requires you to enter the relevant
information and therefore presents a set of navigation and task buttons that you
must use to navigate within the wizard and eventually save the required data.

All the wizard pages in IBM Sterling B2B Integrator use navigation and task
buttons in the same manner, as shown in the following figure:

In this example, the Back button is inactive because this is the first page of a
wizard. The Save button is inactive because you have not yet reached a point in
the configuration at which you can save the data. Similarly, on the last page of a
wizard, the Next button is inactive. To complete a configuration, click Finish. The
system displays Finish and not Save in the last page of a wizard.

As you progress through the various procedures in the IBM Sterling B2B Integrator
wizards, you may find that you have to confirm or change the settings you entered
in a previous page. The Back and Next buttons enable you to navigate freely
among the pages in the flow, while saving the data you entered. At any time, you
can click Cancel to exit the wizard without saving new or modified data.

When you click Finish to complete a configuration, IBM Sterling B2B Integrator
displays a message indicating that the system is updated with the information, and
a Return button. Clicking Return displays the page from which you initiated the
wizard.

The system also displays the Return button on pages that enable you to view a list
or table of information, such as user account names or trading partner profiles, or
detailed information accessed through a link or table. Clicking Return always exits
the current page and displays the page from which you navigated to the
information.

When you navigate the IBM Sterling B2B Integrator interface, use the navigation
tools in the interface instead of the Web browser's Back and Forward arrow
buttons. Using the Back and Forward arrow buttons may cause errors.

Icons

IBM Sterling B2B Integrator uses a set of icons throughout the interface to help you
quickly identify information on pages and to navigate effectively to complete the
required tasks. The following table provides a list of these icons and their
descriptions:

Icon Description

Customize pane or customize portlet displays the Customize pane
for the appropriate tab or the Customize portlet pane for the
portlet.

16 Sterling B2B Integrator: Navigation



Icon Description

Home displays the Admin Console Home page (from the
Administration menu).

Site Map displays a site map of the component you are working
in.

Support displays information about how to get technical
support.

Help opens a separate window to display the Online
Documentation Library, where you can access all of the product
documentation.

News indicates a message posted by an administrator.

Calendar provides you with a means to select a day in the
context of a schedule.

Pane (on the Customize pane) represents a pane in the
Dashboard.

Alert indicates an alert from the system or a system
administrator.

Page information provides instructions about the page you are in
(also called Side Help).

Related steps along with Side Help, this indicates the steps
related to completing the procedure you are in.

Status indicator:

v For business processes – Indicates that the process is not
encountering errors or warnings at this point in the
execution, or has not encountered errors during recent
execution.

Status indicator:

v For business processes – Indicates that the process is in one
of the following states:

– Waiting for other activities to complete before continuing
execution

– Encountering errors or warnings during execution

– Ended and encountered errors or warnings during
execution

or
Information, click to open a separate window to display more
details about the related item.

Edit, click to modify the related item in the list or table (such as
a user account or trading profile identity). In some instances,
this icon may also be displayed without the word ‘edit'.

Delete, click to delete the related item in the list or table.

Copy, click to copy the selected item in the table or list, such as
a trading partner profile.

Clear removes a corresponding selection from a list or table
display.

No security indicates that the item or service is not configured
with security settings.

Add, adds a configuration (such as a trading partner) or value
(such as a schedule exclusion value).
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Icon Description

Tree view displays a hierarchical view in a separate window of
the indicated item, such as service types.

List view displays a list view in a separate window of the
indicated item, such as service types.

Filter limits search or selection criteria to the data you enter.

Move buttons enables you to select items in a side-by-side pair
of lists and move them back and forth between lists. The
double arrow moves the entire contents of the list. A single
arrow moves only the selected item.

Warning precedes a system message. If this icon is displayed,
contact the administrator.

Refresh, click to refresh the data to display the most current
information.

Required Fields
IBM Sterling B2B Integrator requires you to enter data in certain fields before you
can progress to the next page in a procedure or to complete a task. These fields are
called required fields.

In the Admin Console pane, these fields are indicated by colored text for field
names.

The following figure shows the required fields in the Admin Console pane:
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Note: Within some applications the asterisks (*) indicates required fields.

If you attempt to progress to the next page in a procedure without providing
information in all the required fields, IBM Sterling B2B Integrator displays a
system message indicating the missing information. You cannot progress further
until you provide the necessary data.

Date and Time Formats
The IBM Sterling B2B Integrator interface uses a variety of formats for date fields
in the interface. Some fields provide an example entry to guide you. The following
figure shows one such field:

In some pages, the format for the date fields is not provided. If you are not sure,
enter the date in the MM/DD/YYYY format. If the format you have used is
incorrect, when you try to progress to the next step in the procedure or attempt to
save the information, IBM Sterling B2B Integrator displays a system message with
instructions about the required format.

Note: Your system administrator may have set up a custom format for Date and
Time. If so, they can provide you with the necessary instructions.

Enter time values in the following HH:MM format. In search fields that contain
boxes for entering both a calendar date and a time, if you enter a date, you must
also enter the time and if you enter the time, you must also enter a date.

Filter and Group Selection Fields
Some wizard pages within a procedure use filter fields to ease the process of
selecting the appropriate data for a value. Filter fields enable you to limit the
options. Often, filter fields are used in conjunction with group selection fields and
move buttons, which make it easy for you to select a group of options at one go.
The following figure shows an example of a filter field and group selection fields
in the IBM Sterling B2B Integrator interface:
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To use a filter field, type the complete word, partial word, or phrase in the field

and click the filter icon . IBM Sterling B2B Integrator displays only options
that match your filter criteria in the available options list. You can enter new filter
criteria and repeat the process as many times as required. Each time you filter the
display, the list displays only the entries that match your most recent filter request.

To restore the entire contents of the list, clear the filter field and click the filter
icon.

Group selection fields enable you to select or remove options, either individually
or in groups. The left pane contains the available options. The right pane contains
the options you select (these are ‘assigned' options). To use the group selection
fields, use the move buttons as described next:
v Click the right double-arrow to move all options from the Available pane to the

Assigned pane.
v Select one or more options and click the right single-arrow to move your options

from the Available pane to the Assigned pane.
v Click the left double-arrow to move all options from the Assigned pane to the

Available pane.
v Select one or more options and click the left single-arrow to move your options

from the Assigned pane to the Available pane.
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Searches
The IBM Sterling B2B Integrator interface supports a variety of simple and
advanced searches. For example, you can either perform a simple search to locate a
business process by name or an advanced search for a business process by
specifying multiple criteria, including name, date, instance ID, and start time.

The IBM Sterling B2B Integrator interface enables you to search for nearly all the
entities related to your use of the system, from system processes to sets of data
used to regulate or enable processes. For example, you can search for:
v Active, archived, and restored business processes
v Trading partner profiles and related data such as identities, transport, and

packaging information, contracts, and code lists
v Documents processed
v Service activity information and service configurations
v Transaction information
v Interchange information
v Standards information
v Schedules
v Maps
v Resources
v User accounts.

For information about the procedure for searching a specific entity, see the
appropriate topic in the online documentation library.

Basic Search and List Search
Basic standard searches and list searches are used throughout the Admin Console
interface.

Generally, any page in the Admin Console that enables you to enter and save
information, such as a trading profile, service configuration, or user account, also
enables you to perform basic standard searches and list item searches for the items
you save. Use these searches to find previously saved information that you want to
view or modify.

The following figure shows a page in the Admin Console that enables both a
standard basic search and a list search:
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In this example, the basic search enables you to perform a simple search on the
name of a service. The List option enables you to locate a service by listing all the
service configurations, filtering your search based on your alphabetical selection, or
by listing all the services of a selected type.

Throughout the interface, many list searches provide search options that help
narrow down the data to be displayed in the list. Both basic searches and list
searches display results in a list. You can select the corresponding item in the list to
view or modify the related data.

Some basic searches enable you to enter more information to narrow down the
search. The following figure shows a basic search feature that enables you to
provide a variety of search parameters to locate a specific service activity record:
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Advanced Search
From the Administration Menu in the Admin Console pane, you can access a
variety of advanced search options designed to ease the process of locating a range
of data related to your processes.

To locate advanced search options in the Administration Menu, select Business
Processes > Monitor > Advanced Search.

The following figure shows the Advanced search options in the expanded menu:

v Sterling B2B Integrator to search live tables or restore tables for the desired data
you are searching for

v Select date and time ranges
v Specify parameters such as IDs, control numbers, status, related data, and

transport method.

The following figure shows an example advanced search page, the EDIINT
Transaction Search page, that enables you to select the associated contract, status,
and transport type, and enter a start and end date and time:
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Data Flows Search
IBM Sterling B2B Integrator enables you to enter search criteria for tracking data
that is moving into or out of IBM Sterling B2B Integrator by streaming through an
adapter (data flows). You can use the Data Flows page to trace the document path
using the following parameters:
v From the time it is transferred into IBM Sterling B2B Integrator.
v As it is processed by IBM Sterling B2B Integrator.
v When it is transferred out of IBM Sterling B2B Integrator to an external system.

To track data flows, from the Administration Menu, select Business Processes >
Advanced Search > Data Flows. The following figure shows the fields you use in
a typical Data Flows search, populated with sample values:
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Communication Session Records Search
IBM Sterling B2B Integrator enables you to enter search criteria to view
communication session records. These records include the associated
authentication, authorization, file transfer, or non-file transfer records, even if a
document is not transferred and no data flow record is created.

To view communications sessions records, from the Administration Menu, select
Business Processes > Monitor > Communication Sessions. The following figure
shows the fields you use in a typical Communication Sessions search, populated
with sample values:
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Correlation Search
IBM Sterling B2B Integrator enables you to enter correlated search criteria to
perform advanced correlation searching.

Correlation searches rely on name-value pairs to define the specific data items the
system searches for. The defined data items are tracking points for business
processes and documents. For example, instead of searching all of IBM Sterling
B2B Integrator for a particular invoice, you can search for that invoice number,
which saves you time.

IBM Sterling B2B Integrator includes a correlation service that you can use to
define a correlation that enables you to search for a specific data item. Correlations
are either reconfigured and come with IBM Sterling B2B Integrator, or are created
when a process runs.

The data for correlations is stored as name-value pair records in the correlation
table in IBM Sterling B2B Integrator. You can search the data using the Correlation
Search option.

The following figure shows the fields you use in a typical correlation search:
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To enter a name-value pair, you select a value in one or more name fields and type
the appropriate correlated value in the corresponding Value field. The following
figure shows the drop-down menu of options for the Name fields:

The Advanced Search options in the Administration Menu provide specific pages
for performing correlation searches pertaining to EDI interchanges, groups and
transactions, business process specification schemas, and ebXML message flows.

Portlet-Specific Search
Several of the available Dashboard portlets offer capabilities for performing specific
searches, such as searches for business processes, documents, and Internet searches.
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Associated External Applications
IBM Sterling B2B Integrator includes a variety of associated applications that
operate external to the IBM Sterling B2B Integrator interface. Some of these
applications are included with IBM Sterling B2B Integrator and some must be
bought separately, based on your requirements.

The associated applications enable you to perform a variety of activities that are
crucial to managing your processes using IBM Sterling B2B Integrator, such as
creating data transformation maps and developing custom services. The
applications contain features that integrate with IBM Sterling B2B Integrator,
eliminating complex custom development requirements. For example, the
Graphical Process Modeler (GPM) is an external application associated with IBM
Sterling B2B Integrator. Although you install it separately (through the IBM
Sterling B2B Integrator interface) and use it to create business process models in a
graphical palette, the GPM is designed to work with IBM Sterling B2B Integrator; it
enables you to check your processes into IBM Sterling B2B Integrator from the
GPM interface.

The following table describes the external applications that work together with
IBM Sterling B2B Integrator:

Application Description

Map Editor Offline, Windows-based user interface application for mapping
data translation and transformation included with IBM Sterling
B2B Integrator. Use it to translate documents to various data
formats, including EDI, XML, SQL, CII, and others. You include
the appropriate translation map and related services in your
business process models to perform run-time translation.

Graphical Process
Modeler (GPM)

Offline, Windows-based graphical interface tool included with
IBM Sterling B2B Integrator to create and modify business
processes. Converts the graphical representation of business
processes to well-formed BPML (source code), and saves you the
effort of writing code.

AS2 Edition Optional, self-contained, Web-based application based on IBM
Sterling B2B Integrator, which can work with or without the core
IBM Sterling B2B Integrator product. A message management
system enabling the exchange of a variety of documents between
trading partners using secure AS2 EDIINT technology. The
interface uses familiar IBM Sterling B2B Integrator conventions
for ease of use.

MESA Developer Studio A tool used to connect with a IBM Sterling B2B Integrator
instance for resource access and control of IBM Sterling B2B
Integrator operations, change the template that IBM Sterling B2B
Integrator uses, and develop custom services, all from within a
development environment.In addition to MESA Developer
Studio, the following plug-ins are available:

v MESA Developer Studio SDK – For developing and deploying
custom services and adapters. The MESA Developer Studio
SDK requires a separate product license.

v MESA Developer Studio Skin Editor – For customizing the
look and feel of the IBM Sterling B2B Integrator interface.

v Reporting Services – A separately-licensed set of plug-ins used
to create fact models and reports for Reporting Services.
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External applications are installed in different ways. All the associated external
applications are displayed in windows that are separate from the IBM Sterling B2B
Integrator interface.

Access the Map Editor
The Map Editor can be installed only after IBM Sterling B2B Integrator is installed
because the Map Editor has to be downloaded from IBM Sterling B2B Integrator.
An installation wizard guides you through the necessary steps. For more
information about system requirements specific to Map Editor, see System
Requirements.

Open the Map Editor using the appropriate installation folder on your client
computer.

Access the Graphical Process Modeler
The Graphical Process Modeler (GPM) can be installed only after IBM Sterling B2B
Integrator is installed because the GPM has to be downloaded from IBM Sterling
B2B Integrator. While the resource files for the GPM are available on your client
computer after installing IBM Sterling B2B Integrator, the GPM is not automatically
installed on your client computer.

Open the GPM by clicking Go! adjacent to Run Graphical Process Modeler in the
Administration Menu. IBM Sterling B2B Integrator installs the GPM on your client
computer.

IBM Sterling B2B Integrator uses Java
™

Runtime Environment (JRE) 6.0 to launch
the GPM. For more information about system requirements specific to the GPM,
see System Requirements.

Note: When you launch the GPM, the system will verify if you have the Java 6.0
version installed. If you do not have the correct version of Java Runtime
Environment (JRE), you must download Java Runtime Environment (JRE) 6.0 from
the Oracle

®

Sun Development Network Web site before using the GPM. The
minimum disk space required for GPM is 100 MB.

Access the AS2 Edition
To access the AS2 Edition, enter the user ID and password provided to you by
your system administrator for the applications in the IBM Sterling B2B Integrator
login page.

IBM Sterling B2B Integrator enables users to access the application based on the
permissions associated with the user account, and displays the appropriate
interface.

The AS2 Edition is designed using the IBM Sterling B2B Integrator conventions to
make navigation and conventions familiar. Menus, Help options, and procedure
flows work the same way they do in the IBM Sterling B2B Integrator core product
interface.

Access the MESA Developer Studio
IBM Sterling B2B Integrator MESA

™

Developer Studio is an Integrated
Development Environment (IDE) that uses Eclipse software plug-ins. To use the
MESA Developer Studio, you must install Eclipse 3.x, Java 2 SDK Standard Edition
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6.0 or higher, and the MESA Developer Studio Eclipse plug-ins. For more
information about installation and configuration instructions, see the MESA
Developer Studio documentation.

Help Links and Tools

The following table describes the tools and links that provide access to various
help information in the IBM Sterling B2B Integrator interface:

Help Link or Tool Description

Support icon
Displays the Technical Support Contact Information page,
which provides:

v A link to the Customer Center

v Current product versions (for your reference when reporting
problems)

After a product update, the version number that is displayed
depends on the availability of a new license file. If a new
license file is available (upgrade), IBM Sterling B2B
Integrator displays the latest point version. If a new license
file is not available (patch), IBM Sterling B2B Integrator
displays the same point version with the latest build
number.

v A link to the Customer Reference Guide, where you can
view the Technical Support contact information

v The Utility to upload case data to the IBM Sterling B2B
Integrator support link, which allows you to submit a
support request to tehcnical support team

Help icon Opens a separate window to display the online documentation
library.

Page Information
icon (Side Help)

Indicates instructions (printed next to the icon) about using the
interface page you are on or the information displayed on the
page.

Related Steps icon
(Side Help)

Displays page information (Side Help) to indicate the steps
related to completing the procedure you are in.

Support Case Tool Enables you to submit a support request to the techical support
team. You can access this tool using one of the following
methods:

v Click the Support icon. Click Utility to upload case data to
IBM Sterling B2B Integrator support.

v In the Administration Menu, select Operations > System >
Support Tools > Support Case.

Online Documentation Library
The online documentation library is a Web-based hub for all the documentation
pertaining to IBM Sterling B2B Integrator. All product documentation pertaining to
IBM Sterling B2B Integrator is available from the documentation library, for online
viewing and downloading.

The documentation library enables you to:
v Search the content using words, phrases, or boolean (and, or, and and not)

criteria
v Browse the documentation online
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v Download PDF copies of the documentation

Access the documentation library by clicking the Help icon ( ) in the
Administration Menu.

Navigation (5.2.3 or higher) 31



32 Sterling B2B Integrator: Navigation



Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2015. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2015.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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